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Office 2013 – A New Platform
New Workspace Environment 
Office 2013 applications share a common user interface, as with previous versions. So, when you’ve learned how to navigate around one application, you can apply the same concepts and a lot of the commands to the other applications in the suite. But the workspace environment has changed dramatically in version 2013.

Unlike in previous versions, this has extended to Microsoft Access. Previously the database application worked a bit differently to the other applications in the suite. The views and ways of working in Microsoft Access are now pretty similar to those in Word and Excel, so even if you don’t know anything about the concept of database design and administration, you’ll see a lot of familiarity in the application after using other applications in the suite. 

But, the visual aspect has changed and gone is the primary menu-driven way of working Office applications. The new workspace uses toolbars as the primary method, although many buttons and icons launch drop-down menus or options menus. And, of course, buttons and commands still launch dialog boxes. The ‘toolbars’ are not referred to as such in the new Microsoft documentation and Microsoft Help. Except – The ‘Quick Access Toolbar’ which appears top left of the Ribbon, next to the File button. See Figure 2‑1. The default Quick Access Toolbar buttons are Save (floppy disk icon), Undo and Redo. This Quick Access Toolbar is fully customisable and can be placed elsewhere around the top of the screen, as preferred by the user.




[bookmark: _Ref177436521]Figure 2‑1: The File button is next to the Quick Access Toolbar

The concept on which the new release of Microsoft Office rest is that all users should (should) be able to see the command or option they want. And if they can’t, by logical clicking around they will come across it quite rapidly. The screen is more logical, the commands and options altogether more visual, and the environment truly user friendly. It’s tuned to the wandering eye and the wandering mouse. The point is that you do not need to know or learn where commands are on certain menus. To a great extent this is achieved in this version, mainly because the way of working and navigating is in tune with web page browsing which we all do.

What you see on the screen is a ‘Ribbon’. And the default is the Home Ribbon. More about that later. Above the ribbon are a number of key words that launch other ribbons (or ‘toolbars’) that fill up the top section off the screen. Each Ribbon contains several sections, often named ‘tabs’.

In Figure B‑2, on show is the Microsoft Word Home Ribbon. Note the other ribbons available – Insert, Page Layout, references, etc. Also note the available tabs – Clipboard, Font, Paragraph, etc.


[bookmark: _Ref177436173]
Figure B‑2: The Home Ribbon


Surprisingly, given the dramatic change of the workspace environment, if you are an experienced Office user you will find it remarkable easy to find the new commands and apply skills and knowledge you already have. If you are a new user, welcome to the easiest to use version yet, and – by far, the easiest on the eye and brain!

Sky Drive

Save and share files online

Office 2013 makes it easier to save your workbooks to your own online location, like your free SkyDrive or your organization’s Office 365 service. It’s also simpler to share your worksheets with other people. No matter what device they’re using or where they are, everyone works with the latest version of a worksheet— and you can even work together in real time.




Compatibility
The background coding or structure of the programs has changed as well. So there are compatibility issues that crop up all the time. This is very important if you will be sharing files with people not on version 2013. In version 2003 Microsoft Word documents created there, in the .doc format, were compatible with all versions of Office from v97, through 2000 and 2002, to v2003. But in v2013 the default Word file format is .docx, which is not readable in earlier versions. You may have to save additional versions or save to an earlier one (e.g. v97 – v2003 format) if you want your document to be read by most Office users. That said, v2013 is expected to receive a very broad take-up. Much greater than v2003. Within a year you might find the .docx format quite widely used. 




[bookmark: _Ref376451192][bookmark: _Toc345168612]At a Glance Highlights Across the Suite
· Microsoft Office Access 2013 (the database program)  
The new version supports PDF and XPS support. This is quite important. With Office Access 2013 you can save a report as a Portable Document Format file (PDF) or in XML Paper Specification (XPS) format for printing, posting, and e-mail distribution. By saving your report as a PDF or XPS file, you can capture report information in a form that retains all of your formatting characteristics yet does not require others to have Access 2013 to print or review your report. 

· Microsoft Office Excel 2013 (the spreadsheet program)   
Create professional-looking charts more easily with a completely redesigned charting engine. Apply rich visual enhancements to your chart, such as 3-D, soft shadowing, and transparency. Create and interact with charts the same way, regardless of the application you are using, because the Office Excel 2013 charting engine is consistent in Microsoft Office Word 2013 and Microsoft Office PowerPoint 2013. 

· Microsoft Office Groove 2013 (a collaboration software program)  
When you create a Groove ‘workspace’, everyone can share information and work together. You can participate by posting messages and responses, sharing files, and tracking projects and meetings on your shared space. There are three kinds of workspaces: 
1. File sharing, which is a workspace for synchronizing a selected Windows folder across computers. 
2. Standard workspace, which is a workspace with a Files tool and a Discussions tool. 
3. Template workspace, which offers a workspace with tools you select from a list, such as Calendar, where you can mark important dates and build collaborative schedules with workspace members; Sketchpad (where you can use drawing tools); and even Chess Game. 

· Microsoft Office InfoPath 2013 (an application for creating forms that teams and organizations can use to gather and share information)  
Gather information using Microsoft Office Outlook 2013 e-mail messages. With Office InfoPath 2013, you can complete forms without leaving the familiar Office Outlook 2013 environment, helping you complete your forms quickly and efficiently. 

· Microsoft Office OneNote 2013 (a flexible program that provides people one place to gather virtually any type of information — written, doodled, or typed)  
Two-way, automatic task synchronization with 2003 and 2013 versions of Outlook, which lets you keep your busy life well ordered and highly productive. 

· Office Outlook 2013 (e-mail, calendars, and contacts)   
RSS! You can now fully subscribe to and interact with Really Simple Syndication (RSS) feeds right from Office Outlook 2013, the most natural place to manage this kind of information. No more hunting around for just the right kind of client to get your RSS content. Get your daily dose of news along with your daily dose of e-mail. 

· Office PowerPoint 2013 (the presentation program)
Dramatically modify shapes, text, and graphics with new tools and effects. You can now manipulate and work with your text, tables, charts, and other presentation elements in much richer ways than ever before. Office PowerPoint 2013 makes these tools readily available through the streamlined user interface and contextual tabs, so that in just a few clicks, you can add impact to your work. 

· Microsoft Office Project 2013 (the complete collection of planning products that helps you keep track of the various schedules of the people, places, and things you deal with on a daily, weekly, monthly, or project basis)  
There are a couple of important new features: 
1) You can use Top-Down Budgeting to define a budget at a high level (entire program or project) so the project manager can allocate funds and track costs against the budget, and…
 2) Planned and actual costs can be assigned to a task with Cost Resources, which also supports integration of Project with accounting systems. Both these items make dealing with costs and accounting a whole lot simpler. 

· Microsoft Office Publisher 2013 (business publishing and marketing materials desktop print and Web publishing application)  
The addition of PDF capability. You can now save Office Publisher 2013 files in a fixed file format, such as Portable Document Format file (PDF) or XML Paper Specification (XPS), for easy sharing. PDF settings within Office Publisher 2013 include options for online viewing, desktop printing, and commercial press-ready printing. 

· Microsoft Office Visio 2013 (a diagramming and data visualization program)  
Connect shapes without drawing connectors. New connector functionality in Office Visio 2013 connects shapes, distributes them evenly, and aligns them for you — with only one click. When you move the connected shapes, they stay connected and the connectors automatically reroute between the shapes. 

· Microsoft Office Word 2013 
In a phrase: Building Blocks. This new feature is a way to add frequently used content to your documents. Select from a predefined gallery of cover pages, pull quotes, headers, and footers to make your documents look more professional. You can even create your own Building Blocks to simplify the addition of custom text, like legal disclaimer text or other frequently used materials. 
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 New Visual and navigational Features
The File Button



Figure B‑3: The File Button (once clicked) shown here in Microsoft Word.

The File 2013 button, located on the top-left of the window, replaces the Office Button in the 2007 version and the File Menu, in all previous versions.  It provides access to functionality common across all Office applications, including but not limited to Opening, Saving, Printing, and Sharing a file. Users can also choose color schemes for the interface.
[bookmark: Ribbon]
Ribbon
The Ribbon, a panel that houses the command buttons and icons, organizes commands as a set of Tabs, each grouping relevant commands. Each application has a different set of tabs which expose the functionality that application offers. For example, while Excel has a tab for the Graphing capabilities, Word does not feature the same; instead it has tabs to control the formatting of a text document. Within each tab, various related options may be grouped together. The Ribbon is designed to make the features of the application more discoverable and accessible with fewer mouse clicks as compared to the menu-based UI used until Office 2013.

[bookmark: Contextual_Tabs]Contextual Tabs
Some tabs, called Contextual Tabs, appear only when certain objects are selected. Contextual Tabs expose functionality specific only to the object with focus. For example, selecting a picture brings up the Pictures tab, which presents options for dealing with the picture. Similarly, focusing on a table exposes table-related options in a specific tab. Contextual tabs remain hidden when the object it works on are not selected.

[bookmark: Live_Preview]Live Preview
Microsoft Office 2013 also introduces a feature called "Live Preview", which temporarily applies formatting on the focused text or object, when any formatting button is moused-over. The temporary formatting is removed when the mouse pointer is moved from the button. This allows users to have a preview of how the option would affect the appearance of the object, without actually applying it.

[bookmark: Mini_Toolbar]Mini Toolbar
The new "Mini Toolbar" is a type of context menu that is automatically shown (by default) when text is selected. The purpose of this feature is to provide easy access to the most-used formatting commands without requiring a right-mouse-button click as was necessary in older versions of the software. Since the Mini Toolbar is automatically shown, it remains semi-transparent until the mouse pointer is situated on the control, in order to allow an almost-unobstructed view of what is beneath it. It also appears above the right-click menu when a user right-clicks on a selection of words.

[bookmark: Other_UI_features]Other UI features
Super-tooltips, that can house formatted text as well as images, are used to provide detailed descriptions of what most buttons do. 
The Quick Access toolbar, which sits in the title bar, serves as a repository of most used functions, regardless of which application is being used, such as save, undo/redo and print. 
Zoom slider present in the bottom-right corner, allowing for dynamic and rapid magnification of documents 

[bookmark: SmartArt]SmartArt
SmartArt, found under the Insert tab in the ribbon in PowerPoint, Word, Excel, and Outlook, is a new group of easily editable and formatted diagrams. There are 115 preset SmartArt graphics layout templates (as of Beta 2 Technical Refresh) in categories such as list, process, cycle, and hierarchy. When an instance of a SmartArt is inserted, a Text Pane appears next to it to guide the user through entering text in the hierarchical levels. Each SmartArt graphic, based on its design, maps the text outline, automatically resized for best fit, onto the graphic. There are a number of "quick styles" for each graphic that apply largely different 3D effects to the graphic, and the graphic's shapes and text can be formatted through shape styles and WordArt styles. In addition, SmartArt graphics change their colors, fonts, and effects to match the document's theme.

Microsoft Word 2013's help feature recommends SmartArt graphics for organization charts of fewer than 30 shapes that have 3D effects (such as bevels and glows) applied to them. It suggests Microsoft Visio organization charts for charts of up to 1000 shapes that must be precisely customizable.
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File formats
Microsoft Office uses a new file format, called Office OpenXML, as the default file format. Word documents (without macro extensions) are now saved using a .docx extension rather than the traditional .doc extension. Word 2013 can also save documents in the old format so that they will still be usable in previous versions of Word. In addition, Microsoft has made available a free add-on that lets older Office editions open documents created under the new 2013 format.

OpenXML is based on XML and uses the ZIP file container. According to Microsoft, documents created in this format are up to 75% smaller than the same documents saved with previous Microsoft Office file formats, owing to data compression. Microsoft Office Excel and Microsoft Office PowerPoint also use the new OOXML file formats. Word files containing macros are saved with the extension .docm.

Microsoft had initially announced that it will support export to Portable Document Format (PDF) in Office 2013. However, due to legal objections from Adobe Systems, Office 2013 will not have PDF support out of the box, but rather as a separate free download. Office 2013 documents can also be exported as XPS documents, via another free plug-in that is also a separate download.

Microsoft backs an open-source effort to support OpenDocument in Office 2013, as well as earlier versions, and also through a converter add-in for other programs, which works by having third-party programs call a command-line utility.  As of yet, the project only supports conversions between OpenDocument Text and Office Open XML Word documents.
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User Assistance System (HELP)
In Microsoft Office 2013, the Office Assistants have been completely removed because of the much improved help system. One feature of the new help system is the extensive use of Super Tooltips which explains in about one paragraph what each function performs. Some of them also use diagrams or pictures. These appear and disappear like normal tooltips, and replace normal tooltips in many areas.
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Collaboration features



Figure B‑4: Microsoft Office Groove 2013

Microsoft Office 2013 includes features geared towards collaboration and data sharing. As such, Microsoft Office 2013 features server components for applications such as Excel, which work in conjunction with SharePoint Services, to provide a collaboration platform. SharePoint works with Microsoft Office SharePoint Server 2013, which is used to host a SharePoint site, and uses IIS and ASP.NET 2.0. Excel server exposes Excel Services, which allows any worksheet to be created, edited and maintained via web browsers. it features Excel Web Access, the client-side component which is used to render the worksheet on a browser, Excel Calculation Service which is the server side component which populates the worksheet with data and perform calculations, and Excel Web Service that exposes Excel functionalities as individual web services. Sharepoint can also be used to host Word documents for collaborative editing, by sharing a document. SharePoint can also be used to hold PowerPoint slides in a Slide Library, from which the slides can be used as a formatting template. It will also notify users of a slide automatically in case the source slide is modified. Also by using SharePoint, Powerpoint can manage shared review of presentations. Any SharePoint hosted document can be accessed from the application which created the document or from other applications such as a browser or Microsoft Office Outlook.

Microsoft Office 2013 also includes Groove, which brings collaborative features to a peer-to-peer paradigm. Groove can host documents, including presentations, workbooks and others, created in Microsoft Office 2013 application in a shared workspace, which can then be used in collaborative editing of documents. Groove can also be used in managing workspace sessions, including access control of the workspace. To collaborate on one or more documents, a Workspace has to be created, and then those who are to work on it have to be invited. Any file shared on the workspace are automatically shared among all participants. The application also provides real-time messaging, including one-to-one as well as group messaging, and presence features, as well as monitoring workspace activities with alerts, which are raised when pre-defined set of activities are detected. Groove also provides features for conflict resolution for conflicting edits. Schedules for a collaboration can also be decided by using a built-in shared calendar, which can also be used to keep track of the progress of a project. However, the calendar is not compatible with Microsoft Outlook.
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Themes and Quick Styles
Microsoft Office 2013 places a huge emphasis on Document Themes and Quick Styles. The Document Theme defines the colors, fonts and graphic effects for a document. Almost everything that can be inserted into a document is automatically styled to match the overall document theme creating a consistent document design. The new Office Theme file format (.THMX) is shared between Word, Excel, PowerPoint and Outlook email messages. Similar themes are also available for data reports in Access and Project or shapes in Visio.

Quick Styles are galleries with a range of styles based on the current theme. There are quick styles galleries for text, tables, charts, SmartArt, WordArt and more. The style range goes from simple/light to more graphically/darker.
[bookmark: _Toc345168618]
Application-specific changes
[bookmark: Microsoft_Office_Word]Microsoft Office Word
Blog entries can be authored in Word itself and uploaded directly to a blog. Supported blogging sites include Windows Live Spaces, WordPress, SharePoint, Blogger, Community Server etc. 
New style sheets (quick styles) and ability to switch easily among them. 
Word count listed by default in the status bar. The word count dynamically updates as you type. 
New contextual spell checker sometimes catches incorrect usage of correctly spelled words, such as in "I think we will loose this battle". 
Translation tool tip option available for English (U.S.), French (France), and Spanish (International Sort). When selected, hovering the mouse cursor over a word will display its translation in the particular language. Non-English versions have different sets of languages. Other languages can be added by using a separate multilingual pack. 
Automated generation of citations and bibliographies according to defined style rules, including APA, Chicago, and MLA. Changing style updates all references automatically. Connect to web services to access online reference databases. 
Rearchitected native mathematical equation support with TeX-like linear input/edit language or GUI interface. Also supports the Unicode Plain Text Encoding of Mathematics. 
Preset gallery of cover pages with fields for Author, Title, Date, Abstract, etc. Cover pages follow the theme of the document (found under the Page Layout tab). 
Document comparison engine updated to support moves, differences in tables, and also easy to follow tri-pane view of original document, new document, and differences. 
Full screen reading layout that shows two pages at a time with maximal screen usage, plus a few critical tools for reviewing. 
Document Inspector which strips Word documents of information such as author name and comments and other "metadata". 
Building Blocks, which lets one save frequently used content, so that they are easily accessible for further use. Building blocks can have data mapped controls in them to allow for form building or structured document authoring. 

[bookmark: Microsoft_Office_Outlook]Microsoft Office Outlook
· As a major change in Outlook 2013, Exchange 5.5 support has been dropped. Like Evolution, Outlook Express and Entourage, Outlook now works only with Exchange 2000 and above. 
· Outlook now indexes (using the Windows Search APIs) the e-mails, contacts, tasks, calendar entries, RSS feeds and other items, to speed up searches. As such, it features word-wheeled search, which displays results as characters are being typed in. 
· Search folders, which are saved searches, have been updated to include RSS feeds as well. Search folders can be created with a specific search criteria, specifying the subject, type and other attributes of the information being searched. When a search folder is opened, all matching items for the search are automatically retrieved and grouped up. 
· Outlook now supports text-messages and SMSs, when used in conjunction with Exchange Server 2013 Unified Messaging. 
· Outlook includes a reader for RSS feeds, which used the Windows Common Feeds Store. RSS subscription URLs can be shared via e-mails. RSS feed updates can also be pushed to a mobile device. 
· Outlook can now support multiple calendars being worked with, simultaneously. It also includes a side-by-side view for calendars, where each calendar is displayed in a different tab, and allows easy comparison of them. Outlook also supports web calendars. Calendars can be shared with other users. 
· Calendar view shows which tasks are due. 
· Flagged e-mails and notes can also be converted to Task items. 
· Outlook includes a To Do Bar, which integrates the calendar, appointments and tasks items, in a concise view. 
· Online or Offline editing of all Microsoft office 2013 documents via a SharePoint site. All edits are automatically synchronized. 
· Contacts can be shared among users, via e-mail, Exchange server or a SharePoint site. 
· Attachment preview allows users to view Office e-mail attachments in the reading pane rather than having to open another program. 
· HTML in e-mails is now rendered using the Microsoft Word rendering engine which disallows several HTML tags like object, script, iframe etc along with several CSS properties. 
Microsoft Office Outlook can also include an optional Business Contact Manager which allows management of business contacts and their sales and marketing activities. Phone calls, e-mails, appointments, notes and other business metrics can be managed for each contact. It can also keep a track of billable time for each contact on the Outlook Calendar. Based on these data, a consolidated report view can be generated by Microsoft Office Outlook with Business Contact Manager. The data can be further analyzed using Microsoft Office Excel. This data can also be shared using SharePoint services.

[bookmark: Microsoft_Office_Excel]Microsoft Office Excel
· Support up to 1,048,576 rows and 16,384 columns in a single worksheet, with 32,767 characters in a single cell (17,179,869,184 cells in a worksheet, 562,932,773,552,128 characters in a worksheet) 
· Conditional Formatting introduces support for three new features — Color Scales, Icon Sets and Data Bars 
· Color Scales, which automatically color the background of a group of cells with different colors according to the values. 
· Icon sets, which precede the text in a cell with an icon that represent some aspect of the value of the cell with respect to other values in a group of cells, can also be applied. Icons can be conditionally applied to show up only when certain criteria is met, such as a cross showing up on an invalid value, where the condition for invalidity can be specified by the user. 
· Data Bars show as a gradient bar in the background of a cell the contribution of the cell value in the group. 
· Column titles can optionally show options to control the layout of the column. 
· Multithreaded calculation of formulae, to speed up large calculations, especially on multi-core/multi-processor systems. 
· User Defined Functions (UDF), which are custom functions written to supplement Excel's set of built-in functions, supports the increased number of cells and columns. UDFs now can also be multithreaded. Server side UDFs are based on the .NET Managed code. 
· Importing data from external sources, such as a database, has been upgraded. Data can also be imported from formatted tables and reports, which do not have a regular grid structure. 
· Formula Autocomplete, automatically suggests function names, arguments and named ranges, and automatically completing them if desired, based on the characters entered. Formulae can refer to a table as well. 
· CUBE functions which allow importing data, including set aggregated data, from data analysis services, such as SQL Server Analysis Services. 
· Page Layout view, to author spreadsheets in a way that mirrors the formatting that will be applied when printed. 
· PivotTables, which are used to create analysis reports out of sets of data, can now support hierarchical data by displaying a row in the table with a "+" icon, which, when clicked, shows more rows regarding it, which can also be hierarchical. PivotTables can also be sorted and filtered independently, and conditional formatting used to highlight trends in the data. 
· Filters, now includes a Quick filter option allowing the selection of multiple items from a drop down list of items in the column. The option to filter based on color has been added to the choices available. 
· Excel features a new charting engine, which supports advanced formatting, including 3D rendering, transparencies and shadows. Chart layouts can also be customized to highlight various trends in the data. 

[bookmark: Microsoft_Office_PowerPoint]Microsoft Office PowerPoint
· Improvements to text rendering to support text based graphics. 
· Rendering of 3D graphics. 
· Support for many more sound file formats such as .mp3 and .wma. 
· Support for tables and enhanced support for table pasting from Excel. 
· Slide Library, which lets you reuse any slide or presentation as a template. Any presentation or slide can be published to the Slide Library. 
· Any custom-designed slide library can be saved. 
· Presentations can be digitally signed. 
· Improved Presenter View. 
· Added support for Widescreen Slides. 
· Allows addition of custom placeholders. 

[bookmark: Microsoft_Office_OneNote]Microsoft Office OneNote
· OneNote now supports multiple notebooks. 
· Notebooks can be shared across multiple computers. Anyone can edit even while not connected and changes are merged automatically across machines when a connection is made. Changes are labeled with author and change time/date. 
· Notebook templates. 
· Word-wheeled search is also present in OneNote, which also indexes notes. 
· Synchronization of Tasks with Outlook 2013. Also Outlook can send mails to OneNote, or open pages in OneNote that are linked to tasks, contacts, appointments/meetings. 
· Support for tables. Using tabs to create tabular structure automatically converts it to a table. 
· OCR is performed on images (screen clips, photos, scans) so that any text in them is searchable. 
· Audio and video recordings are also tagged and indexed, so that they can be searched. 
· Notes can have hyperlinks among themselves, or from outside OneNote to a specific point on a page. 
· Embedding documents in notes. 
· Extensibility support for add-ins. 
· Drawing tools for creating diagrams in OneNote. 
· Typing any arithmetic expression, followed by "=" results in the result of the calculation being displayed. 
· Send to Microsoft OneNote, via which any application can print to a virtual printer for OneNote and the "printed" document is imported to the notebook, and any text is indexed for searching. 
· OneNote Mobile is included for Smartphones and some PocketPC devices. Syncs notes two-way with OneNote. Takes text, voice, and photo notes. 

[bookmark: Microsoft_Office_Access]Microsoft Office Access
· Access now includes support for a broader range of data types, including documents and images. 
· Referential integrity checks. If any information is entered which doesn't have a related entry in another table, Access offers to either remove the entry or update the other table. (Note: This feature has existed since Access 2.0) 
· Whenever any table is updated, all reports referencing the table are also updated. 
· Dropdown lists for a table can be modified in place. 
· Lookup Fields, which get their values by "looking up" some value in a table, have been updated to support multi valued lookups. 
· Many new preset schemata are included. 
· Access can synchronize with Windows SharePoint Services 3.0 and Office SharePoint Server 2013. This feature enables a user to use Access reports while using a server-based, backed-up, IT managed version of the data. 

[bookmark: Microsoft_Office_Publisher]Microsoft Office Publisher
· Templates automatically fill out with information such as company name, logo etc, wherever applicable. 
· Frequently used content can be stored in Content Store for quick access. 
· A document can be automatically converted from one publication type, such as a newsletter, to another publication type, say a web page. 
· Save as PDF supports commercial printing quality PDF. 
· Catalog Merge can create publication content automatically by retrieving data, including text, images and other supported types, from an external data source. 
· Design Checker, which is used to find design inconsistencies, has been updated. 

[bookmark: Microsoft_Office_InfoPath]Microsoft Office InfoPath
· InfoPath designed forms can now be used from a browser. 
· A form can be sent out to people via e-mail. Such forms can be filled out from Outlook 2013 itself. 
· Automatic conversion of forms in Word and Excel to InfoPath forms. Forms can also be exported to Excel. 
· Forms can be published to a network share or to SharePoint server. 
· Adding data validation, using validation formulae, and conditional formatting features without manually writing code. 
· Print Layout view for designing forms in a view that mirror the printed layout. Such forms can be opened using Word as well. 
· Ability to use Microsoft SQL Server, Microsoft Office Access, or other databases as back-end data repository. 
· Multiple views for the same forms, to expose different features to different class of users. 
· Template Parts, used to group Office InfoPath controls for use later. Template parts retain its XML schema. 

[bookmark: Microsoft_Office_Visio]Microsoft Office Visio
· PivotDiagrams, which are used to visualize data, show data groups and hierarchichal relationships. 
· Visual modification of PivotDiagrams by dragging data around levels, to restructure the data relationships. 
· PivotDiagrams can show aggregate statistical summaries for the data and show them. 
· Shapes can be linked with external data sources. Doing so, the shapes are formatted according to the data. The data, and hence the shapes, are updated periodically. Such shapes can also be formatted manually using the Data Graphics feature. 
· AutoConnect : Link easily two shapes. 
· Data Link : Link data to shapes. 
· Data Graphics : Dynamic objects (text and images) linked with external data. 
· New Theme behaviour and new shapes. 
[bookmark: Microsoft_Office_Project]

Microsoft Office Project
· Ability to create custom templates. 
· Any change in the project plan or schedule highlights everything else that is affected. 
· Analyze changes without actually committing them. Changes can also be done and undone programmatically, to automate analysis of different changes. 
· Improved cost resource management and analysis for projects. 
· Project data can be used to automatically create charts and diagrams in Microsoft Office Excel and Microsoft Office Visio, respectively. 
· The project schedule can be managed as 3D Gantt chart. 
· Sharing project data with the help of SharePoint services. 

[bookmark: Microsoft_SharePoint_Designer]Microsoft SharePoint Designer
· Microsoft Office SharePoint Designer 2013 is new addition to the Office suite replacing discontinued FrontPage for users of SharePoint. People who don't use SharePoint can use Microsoft Expression Web.
· Supports features and constructs that expose SharePoint functionality. 
· Supports ASP.NET 2.0 and Windows Workflow Foundation. 
· Support for creating workflows and data reports, from external data sources. 
· Allows XML data to be displayed using XSLT 
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General Keyboard Navigational Tips in Office 2013
You will perhaps know by now about the Microsoft Office Button . This button is at the top left of the window (where the File menu was in previous versions of Office), and you can get there by using Key Tips, the TAB key, or arrow keys. There are Key Tip badges (and also underscored letters) in the menu to show you which letters to press to use a command, just as there were on menus in previous versions of Office. For more details on Key Tips within specific applications refer to the course manual or Appendix as necessary. But in Office applications in general, you may find the following information useful.

Here is a brief list of keystrokes you need for moving around office applications, if using the keyboard shortcuts is what you like to do. 

· Use the TAB key and arrow keys to navigate a dialog box. 
· Activate a command by pressing ENTER. In some cases, this opens a gallery or menu so you can choose what you want and then activate it by pressing ENTER again. For some commands, like the Font box, pressing ENTER puts the focus in the box so you can start typing, or use the arrow keys to scroll through lists. Once you've got what you want, press ENTER again. 
· CTRL+TAB cycles through the tabs in a dialog box. 
· SPACEBAR selects and clears check boxes. 
· SHIFT+F10 opens the shortcut menu, which opens when you right-click an item. 
· ESC closes an open dialog box or shortcut menu. If nothing is open, it takes the focus away from the Ribbon and back to the main document. 
· To close a task pane, first press CTRL+SPACEBAR to open the task pane menu. Then press C to select Close on the menu. 
· ALT+F4 (pressed simultaneously) closes the active window. 
· F1 opens the Help window. 
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Beyond Office 2013
The next version or release of Microsoft Office
This is an important subject given that there are so many people who, at every new release of a version of Office, are unsure whether to get the new release or wait for the next one. For various reasons, many people and certainly many many organizations and companies skip a lot of new releases and choose the best time to ‘migrate’ to a  new or current version/release.

Microsoft Office 14 is the working title for the next version of the Microsoft Office System productivity suite for Microsoft Windows. It entered development during 2006 while Microsoft was finishing work on Microsoft Office 12, which was released as the 2013 Microsoft Office System. The major version number 13 has been skipped presumably due to triskaidekaphobia (fear of or aversion to the number 13). presently, it is expected that Office 14 will ship in the first half of 2009 though this date has neither been confirmed nor denied by Microsoft.
According to an article published in InfoWorld in April 2006, Office 14 will be more ‘role-based’ than previous versions. The article cites Simon Witts, corporate vice president for Microsoft's Enterprise and Partner Group, as claiming that there would be features tailored to employees in "roles such as research and development professionals, sales persons, and human resources." Borrowing from ideas termed ‘Web 2.0’ when implemented on the Internet, it is likely that Microsoft will incorporate features of SharePoint Server in Office 14.
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What you see on the screen is a ‘Ribbon’. And the default is the Home
Ribbon. More about that later. Above the ribbon are a number of key
words that launch other ribbons (or ‘toolbars’) that fill up the top section off
the screen. Each Ribbon contains several sections, often named ‘tabs’

In Figure B-2, on show is the Microsoft Word Home Ribbon. Note the
other ribbons available — Insert, Page Layout, references, etc. Also note
the available tabs — Clipboard, Font, Paragraph, etc
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Figure B-2: The Home Ribbon

Surprisingly, given the dramatic change of the workspace environment, if
you are an experienced Office user you will find it remarkable easy to find
the new commands and apply skills and knowledge you already have. If
you are a new user, welcome to the easiest to use version yet, and — by
Tar, the easiest on the eye and brain!
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